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PUBLIC ABSTRACT REQUEST SYSTEM OVERVIEW 

PARS is a secure online service that allows authorized account holders to receive driver and/or 

vehicle record abstracts quickly and easily using the Web. Participants have instant access to DMV 

abstracts delivered via Portable Document Format (PDF) images. Typical account holders include 

insurance companies, attorneys, towing companies, transport businesses and other large volume 

requesters. 

System Availability: 

Access to PARS is available 24 hours a day.  Tyler Wisconsin support staff is available to help

with on-line system and application problems.   

Phone:   (608) 250-4606 Between 8 – 4 pm Monday through Friday 

Email:  wi helpdesk@egov.com  

Web:  www.portal.wi.gov/register/ 

Fees: 

The requester is charged $5 for each abstract search that is initiated. The fee applies to the search 

and not to the result.  For instance, if your search results in a response of "no customer match", 

you will still be charged a $5 search fee. 

Billing: 

Fees are automatically debited by electronic funds transfer using the Automated Clearing House 

(ACH) system.  Once enrolled, authorized users will need to enter bank account information into 

PARS to setup their ACH account.  Please consult your financial institution before entering the 

routing and account numbers to ensure accuracy. 

What is ACH: 

The Automated Clearing House (ACH) system is a secure, private network that connects banks to 

one another by way of the Federal Reserve Board or other ACH operators. This network enables 

secure electronic payments to be processed. 

Contract: 

Applicants must sign a PARS data access agreement.  The agreement will expire approximately 

four years from initial enrollment.  A specific expiration date will be provided at the time of 

authorization. It is not required to continue with PARS for the entire four years; length of 

participation within the contract period is up to the participant. 

https://portal.wi.gov/Pages/home.aspx
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User Access: 

A completed MV3758 User Access Request form must be submitted whenever a new user is added 

or an authorized user is deleted.  All users must have their own unique WAMS user ID and 

password. 

Current criminal background checks (no older than 6 months) must be submitted with the MV3758 

form.   

• If you are located in the state of Wisconsin, you are required to use the Wisconsin

Department of Justice to run criminal background checks.  You must keep a copy of the

results on file in your office.

• If you reside outside of Wisconsin, any accredited background check provider can be used.

Contact Tyler Wisconsin:

Contact Tyler Wisconsin for assistance with PARS accounts, and any account updates.  Account

updates may include: changes to your email address, phone number, agreement coordinator, 

adding or deleting users, individual user permissions, etc. 

Phone:   (608) 250-4606 Between 8 – 4 pm Monday through Friday 

Email: wi_helpdesk@egov.com  

Web:   www.portal.wi.gov/register/ 

Note:  You will need to contact Tyler Wisconsin if the individual who signed the PARS

Contract has left your agency. 

Contact DMV: 

Questions on Driver Records:  608-266-2353 

Questions on Vehicle Records:  608-261-2583 

Questions on FED MED: 608-267-2290 
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SYSTEM REQUIREMENTS 

The Wisconsin Department of Transportation is unable to provide software or hardware support for 

non-state owned equipment.  Additionally, due to the nature of the Internet, we cannot ensure your 

connection to state owned resources over public and private networks.   

Network requirements – Internet connectivity 

To access the application, a connection to the Internet is required. 

Firewall and proxy configuration 

WisDOT does not provide support for other organization's infrastructure components, including the 

diagnosis and configuration of firewalls, proxy servers, etc. WisDOT cannot assume any liability 

for problems or outages that may occur either directly or indirectly related to infrastructure 

configuration and support issues. 

 Using a color printer is recommended but not required.  Non-color printers will show colored

entries in shades of gray.

Note:  The Public Driver Abstract System times out after a non-use period of about 15 minutes.  If this 

occurs, simply log on to PARS again. 
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ADOBE READER SETTINGS 

In order to use PARS correctly, you will need to make sure that your ADOBE Reader Settings are 

properly set up. 

When you click a PDF link on a web page, it can open either within the web browser or directly in 

Acrobat or Reader. Each browser has its own settings to control how PDFs open from a web page. 

Acrobat XI and Reader XI do not include a preference setting to open web-based PDFs. To change 

the display behavior, follow the instructions below for your browser, or see the browser 

documentation on how to control plug-ins or add-ons.

Adobe PDF files are identified by an icon . 

Microsoft Edge
1.Open Microsoft Edge
2.Choose Downloads then choose Downloads Settings.
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2. In the Downloads menu Click On the "Open Office Files in the Browser" tab to turn it off

3. On your desktop open the File Explorer
4. Click on Downloads
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5.Right click on the PDF to open drop-down window
6.Choose-   Open with  >  Adobe Acrobat
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Google Chrome 

1. Open Chrome, and go to: chrome://plugins

2. Locate the Adobe PDF plug-in, and do one of the following:

• To have the Adobe PDF plug-in open PDFs in the browser, click Enable.

• To use the Chrome PDF Viewer instead of the Adobe PDF viewer, click Disable for

the Adobe PDF viewer. The Chrome PDF Viewer becomes enabled.

• To have Chrome download PDFs instead of displaying them in the browser, shift-

click Disable for the currently enabled viewer. This leaves both viewer plug-ins

disabled so the PDFs won't display in the browser. 

3. For more information, see the Google Chrome help topic Plug-ins

https://support.google.com/chrome_webstore/?hl=en#topic=6243095
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Mozilla Firefox 

1. Choose Tools > Add-ons.

2. In the Add-ons Manager window, click the Plugins tab, then

select the Acrobat or Reader plugin.

3. Click the Enable or Disable button (it toggles depending on

the status of the selected add-on):

Enable sets plugin to open PDFs in the browser. 

Disable turns off the plugin so it does not open PDFs in the 

browser. 

Select the Acrobat or Reader plugin in the Add-ons Manager. 

4. For more information, see the Mozilla Firefox help topic Using a PDF Reader Plug-in.

https://support.mozilla.org/en-US/kb/view-pdf-files-firefox-or-choose-another-viewer
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Apple Safari 

Make Acrobat or Reader the default viewer for PDFs 

1. In the Finder, select a PDF, and choose File > Get Info.

2. Click the arrow next to Open With to expose the product menu.

3. Choose either Adobe Acrobat or Adobe Reader from the application menu.

Choose Acrobat or Reader from the application menu. 

4. Click the Change All button.

Select Change All in the Open With panel. 

5. When asked if you want to change all similar documents, click Continue.

Safari browser preferences 

1. Launch Safari and go to 'Preferences
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2. In the 'Preferences' window click on 'Security' and then click on 'Website Settings' button

under 'Internet plug-ins'

3. Now select 'Adobe Reader' in the list of plugins.

Under the option 'When visiting other Websites', in the drop down list select 'Allow Always'

and click on 'Done'

Note: This will set the browser to use the 'Adobe Reader' plugin to view pdfs 
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Disable AdobePDFViewer plug-in 

You must have root user privileges to change the Safari plug-ins. To display PDFs using the Safari 

PDF viewer, you must disable the Adobe PDF Viewer. 

1. Quit Safari.

2. Log in as the root user. The root user privileges aren't enabled by default because the root

user can change system files. For more information and instructions, see one of the

following Apple documents: Enabling and using the "root" user in Mac OS X or OS X

Mountain Lion: Enable and disable the root user.

3. Choose Go > Go To Folder.

4. Type /Library in the Go To The Folder field, and click Go.

5. Create a new folder in the Library folder, and name it Internet Plug-ins Disabled.

6. Open the Internet Plug-ins folder, and move both the AdobePDFViewer.plugin and the

AdobePDFViewerNPAPI.plugin into the new Internet Plug-ins Disabled folder.

https://support.apple.com/en-us/102367#:~:text=To%20enable%20the%20root%20user%2C%20choose%20Edit%20%3E%20Enable%20Root%20User,choose%20Edit%20%3E%20Disable%20Root%20User.
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Note: If both AdobePDFViewer plug-ins are still in the Internet Plug-ins folder, drag them now to 

the trash. You may be asked for your name and password. 

For more information, see the Apple Safari help topic If you need to remove a plug-in. 

See also Configure browser to use the Adobe PDF plug-in 

https://support.apple.com/en-us/102343#:~:text=Choose%20Safari%20%3E%20Settings%20(or%20Preferences)%2C%20then%20click%20Extensions,an%20extension%2C%20deselect%20its%20checkbox.
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Problems Reading Adobe PDF files 

• If the PDF file does not load when you click on it, hold down the Ctrl (Control) key and

click on it again.

• If the PDF file does not load while pressing the Ctrl key, click on Refresh. Then try holding

down the Ctrl key and clicking again.

Adobe Reader Support Resources 

The Wisconsin Department of Transportation does not provide support for the Adobe Reader. 

Should you encounter difficulties downloading, installing, configuring, or using the Adobe family 

of products, Adobe has established a detailed support site for addressing issues or problems. 

• Adobe customer support

https://helpx.adobe.com/support.html



Public Abstract Request System 
 14 

FIRST TIME USERS 

All PARS users 

 The first time your organization accesses PARS, your bank account information must

be entered into the system.  Please refer to the Wallet Maintenance, Initial Account

Information section in this manual for step-by-step instructions.

Wallet Maintenance

 Only PARS users designated with ACH authority have the ability to set-up and change

bank account information.  If you have questions regarding who has ACH authority for

your organization, please contact your PARS coordinator.

Note: Bank Account information must be entered before abstracts can be requested.

Employer Notification users only 

 Employer Notification users should immediately enroll their drivers.

 Refer to the “Employer Notification” section for instructions on enrolling your drivers.
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LOG IN 

Access to PARS will be through our DMV data portal provided by Tyler Wisconsin.  PARS

Portal website address: http://www.portal.wi.gov/register/ 

https://portal.wi.gov/Pages/home.aspx
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Click on the PARS link, and the following screen will appear: 

1. Type User ID.

2. Type Password.

3. Click on Login.

Password Problems: 

 Forgot your Wisconsin User ID or password?

 Use the underlined links highlighted in blue for help with account recovery.  Account

recovery is used to restore access to your account if you cannot remember your

password or your Wisconsin User ID.

 You must know the answer to your secret question and you must have access to the e-

mail address used on your WAMS account.

 A link provided in the e-mail is used to recover your account information.  If you have

forgotten what your user ID is, it will appear in parenthesis in the email you will receive.



Welcome Page 

WISCONSlh 0EPARTMHH OF TRANSPORTATION 

lloi11g Busi11ess 
� 

Welcome to the Wisconsin Department ofTransportations Public Abstract Request system (PARS) This 
system is design�d to assist you in accesshg OMV recold information 

A help link to our Public Abstract Request S;stem Manual will assist you with your eectrornc request. 

For Authorized use only All users must corrply with the rastrictions of the Feaeral Drivers Pnvacy Protection 
Act that regulates access to �lotor Vehicle records All usage is tracked Unauthorized use will be reported 
to the appcopriate autho;ties fOf disciplinary and/or legal action 

Account holder usage is limited to the mission and official business functions of their agency. 

If yau experience proble'Tls with system access please contact PARS User Support anytime between 7-JO 
AM and 4·00 PM Monday through Friday at (608) 266-0928 

Sel�ct the organization name you are working on behalf ot

! Select OrganizatLon 

OK 

The PARS welcome screen reminds users that PARS is for authorized use only. 
• Click on the Select Organization drop down arrow to select the appropriate

organization if you have authority on behalf of multiple organizations.
• Click on OK.

Note: The Logo ff link is available in the upper left-hand comer of every page. Click on Logoff to 
exit the system. 
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Main Menu 

-------------------------------------

., ..r. <,,0. • � 

f (II 
State of Wisconsin 

\,. Department of Transportation 

L�ff I PARS Hell! Pag�_I 

Public Abstract Request System 

proce3si::ig on beha'� �F 

0 OMV Abstract Requests 

0 Employer Notification Program 

@Wallet Maintenance 

0 Transaction Audit Report 

Next 

The PARS Main Menu screen appears. 

Note: Users that are not participating in the Employer Notification program and/or do not have 
A CH/Audit Report authority will proceed directly to the DMV Official Transcript Information 
System page. Some of the above features may not be available to all authori::ed users. 

• Select the transaction you want to do:

• Click on OMV Abstract Requests to request and print abstracts.

• Click on Employer Notification System to obtain a list of emolled employees with recent
activity on their driving record, and to access Fed Med Certification Activity. Employers
may order driver record abstracts directly from the Employer Notification screen

• Click on Wallet Maintenance to set up or change ACH bank account information and to
view settlement reports that provide detail account activity.  This option is only available for
PARS users designated with ACH authority.

• Click on Wallet Maintenance to run settlement history reports detailing account activity.
This option is available only for PARS users designated with ACH/Audit Report authority.

• Click on Next.

Public Abstract Request System 
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ACH MAINTENANCE (BANKACCOUNT INFO) 

Only users designated with the ACH role have access to bank account infonnation and account 
histo1y repo1ts. Fees are applied at midnight on the date the abstracts are pulled. 

If your organization has a debit block on your account, you will need to contact your bank. 
You must instruct your bank to allow the State of Wisconsin Company ID of 1522077581 
to process before you enter your ACH payment online.

.. � ... � 
f (If t State of Wisconsin

\,. ,_j./ Department of Transportation 
... ,.., 

L�ff I PARS Help Page I 

Public Abstract Request System 

proce3sing on behalf of 

0 OMV Abstract Requests 

0 Employer Notification Program 

@ Wallet Maintenance 

0 Transaction Audit Report 

Next 

On the PARS Main Menu screen: 
• Click on Wallet Maintenance.
• Click on Next.

Public Abstract Request System
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IMPORTANT • PLEASE READ 

Your Bank Account fraud protection must be configured to allow State of Wisconsin e-payments. 

If the bank account you will be using to rnake your e-check (Automated Clearing House) payment is set up with "debit block" or ''debit fil!ers", before y:ou entfl'r y:our e. 
check PJ!Y.ment on line, you must instruct your bank to allow the State of Wisconsin Company ID ofj jl to process payments. 

ACH Accounts Options Primary 

I Add Payment M:thod I 

I Return I 

The Bank Account screen appears. 
• Click Add Payment Method to add a bank account.

Public Abstract Request System
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The E-Check Information screen appears. 

 Select Checking or Savings

 Type Name on Account

 Type Account number.

 Type Confirm Account Number

 Type Routing Number

 Type Name of Bank

 Complete Billing Information

 Click on Save Payment Method
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The Routing Number is located between the |:   |: symbols and is always 9 digits for a U.S. check.  

See the next page for samples. 

Before entering your bank routing number, please verify the correct number with your financial 

institution.  It is also important to change the routing number and account number if your business 

changes financial institutions. 

On personal checks: 

On business checks: 



IMPORTANT • PLEASE READ 

Your Bank Account fraud protection must be configured to allow State of Wisconsin e-payments. 

If the bank account you will be using to make your e-check (Automated Clearing House) payment is set up with ·debit block" or "debit filters", before you 
check p�yment online, you must instruct your bank to allow the State of Wisconsin Company ID "f I I to process payments. 

ACH Accounts Options Primary 

I :::a:.c ACf. Accounc I 
You must accept the NACHA agreement before this Account Ending in - J �e:�ce ACH Account I account can be selected as primary 

I Accep1; KA�n;. ;..q:een:.er.:c I 

I Acid Payir-enc Mechod I 

I ;lecur::, I 

The Bank Account screen appears with the added account in the list. 
• Click Accept NACHA Agreement
• Click on the appropriate button to select another function, or
• Click on Return to go back to the PARS Main Menu.

Public Abstract Request System
23 
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The NACHA Agreement screen will automatically display. 

 Read and click Next
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The Terms and Conditions screen will automatically display. 

 Read and click Yes, I authorize my transaction.

 Scroll down and click Submit.



Adding an Additional Bank Account 

IMPORTANT • PLEASE READ 

Your Bank Account fraud protection must be configured to allow State of Wisconsin e-payments. 

If the bank account you will be using to make your e-check (Automated Clearing House) payment is set up with "debit block" or "debit filters", befor(l;I, y:ou enter y:our e-
check PJ!Y.ment online, you must instruct your bank to allow the State of Wisconsin Company ID of! jto process payments. 

ACH Accounts Options Primary 

ACfi 

Account Ending in-
I C:dlt Accounc. I 

I l1ake Primary I 
I De:eee 1..CP. Account I 

I Add Pay,r.ent Method I 

I :;tetur:1 I 

On the Bank Account screen: 
• Click Add Payment Method to add a bank account.
• Repeat instructions beginning on page 19.
• Click on Return to go back to the PARS Main Menu

Public Abstract Request System
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Bank Account Changes 

Select primary account 

IMPORTANT· PLEASE READ 

Your Bank Account fraud protection must be configured to allow State of Wisconsin e-payments. 

If the bank account you will be using to make your e-check (Automated Clearing House) payment is set up with "debit block" or "debit filters••, before y:ou i;:inter y:our e,_ 
check PJ!Y.ment online, you must instruct your bank to allow the State of Wisconsin Company ID of I I to process payments. 

ACH Accounts Options Primary 

Account Ending in-
I O:dle ACfi ACcounc. I 

I Make Primiry I 
I Zle:eee l..C� Account I 

� 

I Add Payment Hethod I 

I :S.eturn I 

On the Bank Account screen: 
• Click Make Primary
• Click Make Primary to make selected account the primaiy account.
• The Status in the right-hand column reflects the new primaiy bank account.
• Click on the appropriate button to select another function, or
• Click on Return to go back to the PARS Main Menu.

 27
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Remove Bank Account 

IMPORTANT • PLEASE READ 

Your Bank Account fraud protection must be configured to allow State of Wisconsin e-payments. 

If the bank account you will be using to make your e-check (Automated Clearing House) payment is set up with "debit block" or "debit filters", befor(l;I, y:ou enter y:our e-
check PJ!Y.ment online, you must instruct your bank to allow the State of Wisconsin Company ID of l jto process payments. 

ACH Accounts Options Primary 

ACfi 

Account Ending in-
I C:dlc Account. I 

I l1ake Primary I 
I De:eee 1..CP. Account I 

I Add Payrr.enc Method I 

I :;tecur:, I 

On the Bank Account screen: 
• Click Delete ACH Account

• Click on the appropriate button to select another function, or
• Click on Return to go back to the PARS Main Menu.

Public Abstract Request System
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Transaction Audit Report 

�"'-"'
f (1, � State of Wisconsin

\.;;;;./ Department of Transportation 

LQgoff I PARS Hel� Pag�_I 

Public Abstract Request System 

proce3sing en beha:f of 

0 OMV Abstract Requests 

0 Employer Notification Program 

0 Wallet Maintenance 

@ Transaction Audit Report 

Next 

On the PARS Main Menu screen: 
• Click on Transaction Audit Report.
• Click on Next.

The Audit Report will allow authorized users to nm detailed repo1ts of account histo1y. Only users 
designated with the ACH role or Audit Report role have access to audit reports. 

Public Abstract Request System
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------------------------------------

WISCONSIN DEPARTMENT OF TRANSPORTATION 

lluing Business 
bQQQ!f I PARS Hel P 

Public Abstract Request System 

Audit transaction selection 

glassgowl processing on behalf of PARS USER SUPPORT 

From:�@IJ.112010 

Month Day Year 

To: ��12010 

Month Day Year 

.... [, -.....,Re ... t ... r ... ie
.._

v
._.
e ...... Tr ... a ... n ... s ... ac

..,
t
._.
i ... o .... ns

....._�I] [ Return ]

The Audit Repo1t screen appears. 
• Type beginning date in the From field.
• Type ending date in the To field.
• Click on Retrieve Transactions to retrieve transactions during the specified period.
• Date/Time: Details the date and time of each driver abstract request. The time appears in

militaiy fonnat.
• Requested By: Indicates the name of the PARS user that requested the driver record

abstract.
• Driver Name: Provides the name of person on the driver abstract, or the VIN number.
• Search DID/Name: Details the search criteria submitted that was entered by the PARS user

to request the driver abstract, or vehicle abstract.
• Click on Return to return to the Main Menu.

Public Abstract Request System
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Settlement History 
.._....,co .. � 

f ('"1,} State of Wisconsin

\,,,,.� Department of Transportation

LoqoJf I PARS Helpyaqe I 

Public Abstract Request System

proce3sing en behal= of 

0 OMV Abstract Requests 

0 Employer Notification Program 

@ Wallet Maintenance 

0 Transaction Audit Report 

Nex,;; 

On the PARS Main Menu screen: 

• Click on Wallet Maintenance
• Click on Next

IMPORTANT· PLEASE READ 

Your Bank Account fraud protection must be configured to allow State of Wisconsin e-payments. 

If the bank account you will be using to make your e-check (Automated Clearing House) payment is set up with "debit block" or "debit filters•, before you enter your e­
check pJ!yment online, you rnuSl lnslfuct your l)ank to allow the State of Wisconsin Company ID of 1522077581 to process payments. 

ACH Accounts Options Primary 

I '::di t A:f. Accou:. t I 
Account Ending in- Current Primary 

I Dele'te AC?i Account I 

I Add P,ymenc Method I 

I Settlercent f.istory 11 Retu:r:1 I 

• Click Settlement History

Public Abstract Request System
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Settlement History 

proce3sing on behalf of 

From:c=Jt c=Jt �I _ __,
Month Day Year 

To: c=Jt c=Jt �I _ __,
Month Day Year 

I Retr :.eve Set tlerr.ents 11 Return I 

Settlement Date Reference Number 

The Settlement Hist01y screen appears. 
• Type beginning date in the From field.

• Type ending date in the To field.

Amount Reference Explanation 

• Click on Retrieve Settlements to retrieve transactions during the specified peiiod.

• Date: Details the date of each driver abstract request. The time appears in milita1y fom1at.

• Reference number: Provides the dtivers license nmnber of person on the dtiver abstract, or
the VIN number.

• Amount: Details the amount for each record and a rnnning total for the day.

• Click on Return to return to the Main Menu.
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DMVABSTRACTREQUESTS 

Public Abstract Request System 

processing on behalf of 

@OMV Abstract Requests 

0 Employer Notification Program 

0 Wallet Maintenance 

0 Transaction Audit Report 

Next 

On the PARS Main Menu screen: 
• Click on DMV Abstract Requests.
• Click on Next.

Note: Users that are not pa1ticipating in the Employer Notification program and do not have ACH 
authority will proceed directly to the DMV Abstract Requests page. 

Public Abstract Request System
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Driver or Vehicle Abstracts 

-------------------------------------

WISCONSIN DEPARTMENT OF TRANSPORTATION 

1lui11g Busi11ess 
bQQQ!! PARS He! P 

Public Abstract Request System 

Order Abstract Request 

glassgowl processing on behalf of PARS USER SUPPORT 

Select the type of abstract you would like to order: 

0 Driver Record Abstract O Vehicle Record Abstract

Main Menu 

On the Order Abstract request screen: 
• Choose the type of abstract you want to request
• Click on Main Menu if you want to return to the previous screen.

Note: Users that are not participating in both Driver Record and Vehicle Record request options 
will not see this screen. 

Public Abstract Request System
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Order a Driver Abstract 

WISCONSIN [>El'AIITMENT OF TRANSl'ORTAHON 

U11i11g B11si11ess 
1=._QgQff � 

Public Abstract Request System 

Order Abstract Re-quest 

Sele-ct the typ,e- of abstractyou would like toorde-r: 

0 Criver Record A!nt:r9ct 0 Vehide Rec::mi A.b-st:ract 

Driver Abstract 

Req.J:51in3 3 d•iv:• :a,ntract will ·=su Ii in 3 fee Fies� n::,ie 1"13i.r:q�e5iing dri•,=• re:::crd;.wit'i inoo'TI-olet: er 
insccu·:at:: i'1b·.,,ati.::n ·...-ill :,ii;.::, •:;.ult i" i nco-ing a fe: ,,.·itn s •,;:i �u;.t,:imar tdatcn arot-sct ::::Ei,.,g g:nE•:31':d 

Enter Wisconsin DriveI 
Licen�= Nu-noe-1: 

Middle lnitisl: 

Ost<: of Birth 
□ 
.__ __ __,I (fomi�t mmddJIY.!/J,1 

� __ ?u_r_ch_ .. _,,_e_..n_Ab_:o_t_r._cc_1C. __ �J [ �-.::..n Y-enu ] [ Cl.c•r E"�c1ci� 

The Order Abstract Request screen appears. 

OR: 

• Type Wisconsin Driver License# in the Enter Driver License Number field ( do not use
spaces or dashes).

• If you do not have a driver license#:
• Type First Name. Tab.
• Type Middle Initial. Tab.
• Type Last Name. Tab.
• Type Sex (For M). Tab.
• Type Birth Date (nun/dd/yyyy).
• Click on Purchase an Abstract to continue processing, or
• Click on Main Menu to cancel transaction.

For record requests using Name, Sex, and Date of Birth: Enter the complete name. The middle 
initial is required if it appears on the DMV data records. 

Requesting driver records with incomplete or inaccurate information will result in incurring a 

fee with a "No Customer Match" abstract being generated. 

Note: You cannot enter both the driver license number and name, sex, date of birth on the same 
inquiry search. We recommend searching by driver license number whenever possible. 
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The Adobe PDF dialog box appears. 

• To view or print Driver Record Abstract:

• Click on . 

• If you want to print the document, follow printing instructions based on your system’s set-up

for Adobe Acrobat documents.

• Close Adobe window.

OR

• Click on Previous Page to return to the Order Abstract screen.

OR

• Click on Return to Main Menu to go the PARS Main Menu screen.

 Note: If you forget to print an abstract, or experience computer problems while ordering an 

abstract, you can order the same abstract again (on the same day) and you will not be charged 

more than one time. 

Please call (608) 266-2353, if you have a question on the information contained on the driver 

abstract.  



Order a Vehicle Abstract 

Public Abstract Request System 

Order Abstract Reque·st 

Sele-ct the type of abstra.et you would like to order: 

Vehicle Abstra-et 

Tir="=' : c  "'s::_-=.::-. ....-" E---J ==:!.",...,,.. -::..JJ-;i t--:-.::t-3.l'"e-..:Jt -2. 'L:".'51:--;: qe�-J =:: .. "": ,..1:::1:..:-.:2. 
fo-" .:3::t ''=5..1. ts c i:-55':' r·a-oe SJ"e L""a- -.:c, ... ·;1.:-yc .. e-te· s o: .. ,..c .:t-e a-:i .a;::. ..... ate. 

$;.:w:t- c,y: 

Ve� c': ll Nurd:,;.r{VIN}· 

= ;;.t;. Nurrber: • 

or 

or 

!) s 

vj 

Ca.te o' e.· rtr: 

C,ty: 

�--�I (fa.miiir mnd'd.YYYJ,? G.:r:l2r: I ---�-1..e-c-::--- v I 

,----------------, St.ote: E!J Zip: CJ 
I----- �elece ----- V 

• sp-2-�j• ::.s r2�1.ureJ -=·= J{s) •or ti:5-t .::>�rct. 

E=-uct H:c p: Ao.: r;i ff ;,r:> j;'c-rrr-ation ,r 2:;.cr o' tr-='= :s wil .r:c p r.:;.myw yoi._r ==-:;.r�J-. 

Vehicle Records may be searched by entering only one of fom different types of infonnation. 

• Vehicle Identification Number (VIN)

• Type the entire VIN, use a zero (0) instead of the letter "O"
• VINs vru.y in length from 1 to 21 alpha/numeric characters

• License Plate Number

• Type the entire plate number with no spaces or dashes between the digits even if they
appear on the plate; do not use "O" but instead use a zero (0). Dealer, Tribal and 
App01tioned plates are not viewable with this program. 

• When entering a license plate for a vehicle that has a weight sticker, do not enter the
weight sticker as pa1t of the plate number 

• Select the license plate type if you know it; adding this info1mation will reduce the
number of records returned by the system 

Note: When reviewing a list of plates or vehicles to select you will notice a license plate "Status" 
will be included. This status does not reflect if the license plate is expired. "Valid" 
indicates the plate still belongs to the registered ovmer and has not been cancelled or 
reported stolen. Even if the license plate is not associated to a vehicle, the "Status" will still 
reflect "Valid" if it has not been cancelled, reported stolen or has expired. 
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• Business or Organization Name- "Non-Individual"
• Type the business name as close to its official title as possible including "INC" or

"LLC" if applicable
• Most DMV records do not contain punctuations; enter "INC" instead of "Inc."

• Individual name

• Type the conect spelling of the last and first name
• Type a middle initial when it is known

There are additional fields in the individual name area. Entering more infonnation in these 

additional fields will help reduce the number of records returned for your search. 

Note: You cannot enter inf01mation in more than one area of criteria, e.g. you cannot enter a VIN 

and license plate number or a license plate number and a customer name. You must choose one of 
the four areas. 

Once you have entered your search criteria, verify the infonnation is accurate. 
• Click on "Purchase an Abstract" to proceed, or
• Click on "Main Menu" to return to the program option choices

Non Individual name:* lcusTOMER PARS I 

or 

First Name:� I I Ml:□ Last Name:* I 
plus 

Date of Birth: I I (format mmddyyyy) Gender: I ---Select---

City: 

County: 
I 

1----- Select

* specifies required field(s) for that search

I State: @!) 
----- v,I 

Search Help: Adding more information in each of the fields will help narrow your search.

( Purchase an Abstract ) [ Main Menu I I Clear Fields 

Zip: 

I 

I Suffix: I 

vi! 
I I 

Important: When the "Purchase an Abstract" button is selected your account will be charged a $5 

search fee. One of the following will appear: 

• A list of customers from which to choose
• The record for which you were searching
• A pop-up screen indicating "No matching record found for the info1mation entered"

When you receive a list to select a specific record, you will not be charged an additional fee for 
the first abstract. You may return to the list by clicking on the "Previous Page" button to select 
another customer or plate to purchase an additional abstract. If you return to the "New Search" 
screen without selecting an abstract your account is still charged a $5 fee. 
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When entering a Vehicle Identification Number (VIN) or License Plate Number you will usually 
receive an abstract directly. The abstract will be preceded by a pop-up screen that will give you the 
option of opening the record or saving it to a specific location on yom computer. We recommend 
you save the abstract in case there is difficulty with yom printer or you need to refer to it for 
additional info1mation. 

----------------------

Fi le Down load � 

Do you want to open or save this file? 

-m 
Name: Vehicle_Abstract_1G2MB33886Yl08536.pdf 
Type: Adobe Acrobat Document, 12,0KB 

From: acceptance.dot.state,wi,us 

Qpen ] [ �ave 

While files from the Internet can be useful, some files can potentially 
harm your computer. If you do not trust the source. do not open or 
save this file. What's the risk? 

If you choose "Cancel" on this screen you will still be charged the $5 search fee. 

When entering a Non-Individual Name or a Customer Name you may receive a list of customer 
records from which to choose. Review the list for the record matching your request. The list will 
contain the following information: 

• Name
• Gender (individual only)
• Age (individual only)
• Address: Street, city, state, zip code and county

[ Select ] 

[ Select ] 

[ Select ] 

[ Select ] 

[ Select ] 

[ Select J 

[ Select ] 

Name: FEMALE CUSTOMER Gender: Female Age: 26 
Address: 123 MAIN STREET MILWAUKEE. WI 53205-2541 MILWAUKEE 

Name: FEMALE cus TOMER

Address: 123 MAIN STREET

Name: FEMALE CUSTOMER

Address: 123 MAIN STREET

Name: FEMALE cus TOMER

Address: 123 MAIN STREET

Name: FEMALE cus TOMER

Address: 123 MAIN STREET

Name: FEMALE CUSTOMER

Address: 123 MAIN STREET

Name: FEMALE CUSTOMER

Address: 123 MAIN STREET

Gender: Female Age: 29 
FORT ATKINSON. WI 53538 JEFFERSON 

Gender: Female Age: 53 
ILWAUKEE. WI 53216 MILWAUKEE 

Gender: Unknown Age: 
ILWAUKEE. WI 53208-2362 MILWAUKEE 

Gender: Female Age: 4 7 
MILWAUKEE. WI 53212 MILWAUKEE 

Gender: Female Age: 51 
MIDDLETON. WI 53562 DANE 

Gender: Female Age: 50 
PEWAUKEE. WI 53072 WAUKESHA 
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Select a record. The next screen will contain the customer record infonnation and a list of vehicles 
associated with this customer. 

Owner Details 

I Identifiers I NSD ID: XXXX-XXXX-XX67-05

I Name I LAST NAME FIRST NAME MI 

I Primary Address 123 MAIN STREET MILWAUKEE liJI 53202 MILWAUKEE 

I Details I Age: 45 Gender: Female

� -�

Title Status: VALID Reg Status: VALID Role: OlJN

I Purchase l Year: 1997 Make: SUBARU Type: AUTO Style: SlJ

I Purchase l 
Title Status: VALID Reg Status: HISTORY Role: OlJN

Year: 2006 Make: PONTIAC Type: AUTO Style: CP

Title Status: HISTORY Reg Status: HISTORY Role: OlJN

I Purchase l Year: 2005 Make: CHEVROLET Type: AUTO Style: CP

The vehicles associated with this customer will display the: 

Title status: 

• Valid -CmTently titled to the customer listed above
• Histo1y -Title has been transfened to someone else or the vehicle has been recorded

as junked.

Registration Status: 

Role: 

• Valid -Plate is still owned by the customer listed above; this is not an indication of
whether the plate is cmTent or expired.

• History -Plate has been cancelled, repo1ted as stolen or destroyed.

• Own -Owner on record

Note: See the DMV Abstract Manual for an explanation of the different statuses and roles 
listed. 

Select the "Purchase" button to view the vehicle's abstract. 
• If the vehicle has a Histo1y status and you click on the "Pm-chase" button, the abstract

you receive:
• Will be for the cmTent owner of the vehicle if the vehicle was sold
• The historical title if the vehicle was junked.
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Duplicate Records 

When entering the VIN or a license plate number, the vehicle abstract will appear unless there is a 
duplicate record for the same entiy. A light tiuck plate may have the same number as a semi-trailer 
plate. If this occurs, a list will appear identifying the plate type for you to select an absti·act. 

WISCONSIN DEPARTMENT OF TRANSPORTATION 

llui11g Husi11ess 
lQgQll PARS Hel P 

Public Abstract Request System 

Vehicle Plate Search Results 

glassgowl processing on behalf of PARS USER SUPPORT 

Search Criteria: Plate Number: DL 1005 

11 Purchase j Plate Number: DLl 005 
Vehicle Type: 

Plate Number: DL1005 

Plate Ty�e: TMP 
Vehicle Make: 

Plate TyJ}e: LTK 

Plate Status: ALLOCATED 
Vehicle Model: 

Plate Status: ASSIGNED [Purchase] 
Vehicle TyJ}e: TRUCK Vehicle Make: GMC Vehicle Model: GM4GK1 

New Search ] [ Main Menu 

If a multiple VIN record exists, you will receive a message to contact the DMV for assistance. 

Please call (608) 264-7447 for the DMV Contact Center, if you have a question on the infonnation 
contained on the vehicle absti-act. 

Note: See the on line Interpreting Public DMV Abstracts Manual for a list of the plate type 

abbreviations and their corresponding names. 
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EMPLOYER NOTIFICATION PROGRAM OVERVIEW 

Employer Notification is an optional program for PARS participants.  Employer Notification 

provides employers with current information regarding the driving record of their enrolled 

employees.  Employers may enroll any employee whose employment responsibilities include the 

operation of any motor vehicle.  Wisconsin Statutes 343.245 authorizes this program.   

Employer Notification allows participants to create and maintain their own roster of employed 

drivers.  The system is designed to have participants logon and check for employee driving activity.  

As detailed in the following pages, the system will identify all enrolled drivers with recent activity 

on their driving record and enable the purchase of their driving record abstract.  Activity should be 

monitored on a regular basis, as determined by your particular business needs.   

As a courtesy reminder, the PARS system will automatically send an e-mail each Monday 

morning to the designated PARS Agreement Coordinator if there has been recent activity on one or 

more drivers and an abstract has not yet been requested.  Participants will only receive an e-mail if 

there has been recent activity and a driving record has not yet been requested.   

We encourage PARS participants not to solely rely on these e-mails.  E-mail delivery can be 

disrupted by elements beyond the control of DOT, including firewalls, spam filters, and suspended 

or disabled e-mail accounts.   

What Triggers Employer Notifications? 

Records will update when an event is added or changed:

• WI Accident Date

• Accident Severity

• Violation Date

• Conviction Date

• Charge Code

• MPH Over

• Minor in Vehicle

• Operating Class

• Violation Directive

• OOS Violation Date

• OOS Conviction Date

• OOS Charge Code

• OOS Operating Class

• OOS Violation Directive

• Withdrawal Effective Date

• Withdrawal Release Date

• Withdrawal Charge Code

• Length of Withdrawal

• H endorsement due - Notifies employer 60 days prior to H endorsement renewal date.

• School Bus Follow-up - Initial/Next - no charge
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 Records will update when an event is added:

• OOS Accident

• OOS Withdrawal

• Moved to another state

• Product Notations  (Out-of-Service Withdrawals only)

Triggers Related to Fed Med 

• New or updated accident (WI or Out of State)

• New or updated trackable, non-confidential violation (WI or Out of State)

• New  or updated non-confidential withdrawal (WI or Out of State)

• New moved out of state entry

• New or updated H” - Hazmat restriction

• New or updated 51” - Intrastate restriction

• New or updated K” - Interstate restriction

• New CDL Self Certification

• New product notation 63 - 24 hour out of service

• School Bus Medical Follow-up

• Fed Med - MEDC - Medical Certificate Follow-up (Restriction expiring in 10 days, 60 days

to med certificate expiration)

• Fed Med - MEDS - Medical Certification Status (Not Certified)

• Tier change

• Med cert notification:

• 60 day (expiring in 60 days)

• 0 day (expired today - not medically certified)

• 10 day (now VTSed)

Additional information:

• If a withdrawal, violation, or restriction is added to the driver record, the employer is

notified.  If DOT then removes it, the notification is still made to the employer.
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EMPLOYER NOTIFICATION PROGRAM 

On the PARS Main Menu screen: 

 Click on Employer Notification Program.

 Click on Next.
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The Employee Notification System screen appears. 

 Employee Enrollment – use to add, remove, or review employees in the Employer

Notification Program.  Driver license numbers must be used when adding or removing

employees from the Employee Enrollment list.

 Employee Activity – provides a list identifying all enrolled employees with recent

activity on their Driver Record.  This will provide a list of employees with new

convictions, withdrawals, accidents, etc.

 Fed Med Certification Activity – provides a list identifying all enrolled employees

with recent activity that relates to their medical certification (Fed Med card or tier).

This will provide a list of employees with Fed Med cards that are about to expire or

when there is a change in tier.  Employers are able to upload Fed Med Cards through

this function.

 Order Abstract – use to order a driver abstract directly from the Employee

Notification System screen.
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Employee Enrollment 

On the Employee Notification System screen: 

 Click on Employee Enrollment.

 Click on Continue to continue processing, or

 Click on Cancel to cancel transaction and return to PARS Main Menu.
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Add Employee to Notification List 

The Employee Enrollment screen appears. 

 Click on Add Employee to Notification List.

 Click on Continue to continue processing, or

 Click on Cancel to cancel transaction.

The Add Employee screen appears. 

 Type Wisconsin Driver License# in the Enter Driver License Number field (do not use

spaces or dashes).  Note:  If the customer had a previous driver license number due to a

name change or date of birth correction, the current driver license number will appear

on the Add Employee Confirmation screen.

 Click on Next to continue processing, or

 Click on Cancel to cancel transaction.
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The Add Employee Confirmation screen appears. 

 Verify that this is the correct employee.

 Click on Confirm to Add Employee to continue processing, or

 Click on Cancel to cancel transaction.

 Click on the box for Check to Purchase an Abstract, and you will be able to order an

abstract as you add each employee.
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The Adobe PDF dialog box appears. 

• To view or print Driver Record Abstract:

• Click on . 

• If you want to print the document, follow printing instructions based on your system’s set-up

for Adobe Acrobat documents.

• Close Adobe window.

OR

• Click on Previous Page to return to the Employee Enrollment screen.

OR

• Click on Return to Main Menu to go the PARS Main Menu screen.

Note:  If you forget to print an abstract, or experience computer problems while ordering an 

abstract, you can order the same abstract again (on the same day) and you will not be charged 

more than one time. 

Please call (608) 266-2353, if you have a question on the information contained on the driver 

abstract.  
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Error Messages When Adding Employees 

This indicates your account is not allowing drivers to be enrolled that do not have a Commercial 

Driver License.  Call PARS Support if you wish to have your account setting changed to allow 

Class D (regular) drivers. 

 Click on OK.

 You will return to the Add Employee screen.

The above error message indicates and employee has already been enrolled. 

 Click on OK.

 You will return to the Add Employee screen.

The above error message indicates no driver license can be found for the number entered.  The 

number was either entered incorrectly or the driver license number does not exist. 

 Click on OK.

 You will return to the Add Employee screen.
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Remove Employee from Notification List 

On the Employee Enrollment screen: 

 Click on Remove Employee from Notification List.

 Click on Continue to continue processing, or

 Click on Cancel to cancel transaction.

Note:   This should be done when an employee is no longer employed by your agency.  Failure to 

remove the employee will result in notifications continuing for this person.   

The Delete Employee screen appears. 

 Type Wisconsin Driver License# in the Enter Driver License Number field (do not use

spaces or dashes).

 Click on Next to continue processing, or

 Click on Cancel to cancel transaction.
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The Delete Employee Confirmation screen appears. 

 Verify that this is the correct employee.

 Click on Confirm to Remove from List to continue processing, or

 Click on Cancel to cancel transaction.

The Successfully Deleted Employee(s) dialog box appears. 

 Click on OK.  You will return to the Delete Employee screen.
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View List of all Employees Enrolled 

On the Employee Enrollment screen: 

 Click on View List of All Employees Enrolled.

 Click on Continue to continue processing, or

 Click on Cancel to cancel transaction.

If no employees have been enrolled yet, you will receive the following error message: 

The Employee Enrollment List appears. 

The Employee Enrollment List displays the name and driver license number of every employee 

currently enrolled in the system.  Employees may also be deleted or added using this screen.  Driver 

record abstracts may also be ordered directly from this page. 
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Note:  The employee enrollment list can be printed directly from this screen.  Click on the Show All 

button and then Select the print function on your Internet browser. 
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Order Abstracts from Employee Enrollment List 

On the Employee Enrollment List: 

 Click on Purchase Abstract button to purchase and print an abstract from this screen.
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Delete Employee from Employee Enrollment List 

On the Employee Enrollment List: 

 Click on Delete check box in front of each employee you wish to remove from the

enrollment.

 Click on Remove Employee(s) from list.

The Delete Employee Confirmation screen appears. 

 Click on Confirm to Remove from List to remove the employee.

 An “X” appears under the Delete column by the employee who was removed.  The

entry will be removed entirely upon exiting this screen.

 Click on Cancel to cancel transaction and return to the Employee Enrollment List.
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Add Employee from Employee Enrollment List 

On the Employee Enrollment List: 

 Click on Add Employee button.

 The Add Employee screen appears.  See “Add employee to notification list” section for

details on adding an employee.
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Employee Activity 

On the Employee Notification System screen: 

 Click on Employee Activity.

 Click on Continue to continue processing, or

 Click on Cancel to cancel transaction and return to PARS Main Menu.

Employee Activity provides a list identifying all enrolled employees with recent activity on their 

Driver Record.  This provides a list of employees with new convictions, withdrawals, accidents, etc.

Employer notify emails are sent out automatically on Monday's.
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The Employee Activity screen appears. 

 Click on Purchase Abstract to request an abstract.

 A red asterisk (*) will appear on the left-hand Abstract Ordered column after requesting

the abstract.

Note:  Selected employees will no longer appear on this screen the next time you run Employee 

Activity. 

Note:  Employees will remain listed until an abstract is purchased. 
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School Bus Medical 

School bus medical follow-ups are generated when a driver with a school bus endorsement has a 

medical requirement that needs to be met.  The notification appears 60-days before the school bus 

medical due date.  The notification will not disappear until after the due date, even if the driver has 

complied with the requirement.   

It is the employer’s choice whether or not to purchase a driver record when a school bus follow-up 

notification appears.  If the driver does not comply with the requirements, their school bus 

endorsement will be cancelled and a new notification will be generated for the cancel. 
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Fed Med Certification Activity 

On the Employee Notification System screen: 

 Click on Fed Med Certification Activity.

 Click on Continue to continue processing, or

 Click on Cancel to cancel transaction and return to PARS Main Menu.
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The Federal Medical Certification Activity Screen 

Clicking on Tier Information will open up the window to look like this: 

• You can choose to Sort By Name OR Sort By Med Exp Date by clicking on this button

• Clicking Return will take you to the previous screen

• This screen shows you:

 The DID number for the employee listed

 The Employees Name

 The Notification Type.  Some possible Notifications are:

 K RESTRICTION:  added/removed on license.   K=No CMV Operation

Interstate, unless excepted

 51 RESTRICTION:  added/removed on license. 51=No CMV Operation

Intrastate, unless excepted

 MEDICAL CERTIFICATE FOLLOW-UP:  60 day follow-up notification

letter sent saying the Fed Med will expire in 60 days (only occurs for Tier 1)

 MEDICAL CERTIFICATION STATUS:  Fed Med Certification Status

change (only occurs for Tier 1)

 CDL SELF-CERTIFICATION:  New or change to a self certification (tier)
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 Once you have determined to either purchase an abstract or not, you can click

on the “Notification Reviewed” button to remove this person from the Notification.  If

you do not purchase or remove, the employee will remain listed and you will continue

to receive notifications.

• The Employee’s Current Tier

• Tier 1: Non-excepted interstate – Employee needs to provide a valid Fed Med

card to DMV.

• Tier 2: Excepted interstate – Employee does not need a Fed Med card.

Employee is engaged in interstate commerce and subject to one of the

exceptions listed on the Help Page.

• Tier 3: Non-excepted intrastate – Employee needs a valid Fed Med card to

drive a commercial vehicle.

• Tier 4: Excepted intrastate – Employee does not need a Fed Med card.

Employee is engaged in intrastate commerce and subject to one of the

exceptions as follows:

• Tow trucks (if requested by a federal, state or local officer to move

a wrecked or disabled vehicle).

• Grandfathered (held valid CDL since July 29, 1996, that has not

been revoked).

• Wisconsin diabetes exemption to the Fed Med card.

• Wisconsin vision exemption to the Fed Med card.

• All exceptions listed on the Help Page under Tier 2, only

completed within intrastate commerce.

• Current Certification: Not-Certified means the driver can’t operate under Tier 1, they

may still have a valid Fed Med card.

• Fed Med Exp Date:  Expiration date of the current Fed Med card on system with the

DMV.

• Notify Date
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Order Abstract 

On the Employee Notification System screen: 

 Click on Order Abstract.

 Click on Continue to continue processing, or

 Click on Cancel to cancel transaction and return to PARS Main Menu.

The Order Abstract screen appears. 

 Type Wisconsin Driver License# in the Enter Driver License Number field (do not use

spaces or dashes).

 Click on Purchase an Abstract to continue processing, or

 Click on Cancel to cancel transaction.

Requesting driver records with inaccurate information will result in incurring a fee with a 

"No Customer Match" abstract being generated. 
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LOGOFF 

Click on Logoff link found in the upper left-hand corner of most screens in this program. 

The Signed off message appears. 
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